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Readme First 

 

 Imagistik is a graphics viewer for multi-page Tiff and other image formats.  The program offers an 

extensive array of features and markup functions. Imagistik also features basic Optical Character 

Recognition (OCR) functions.  Please read the entire user guide. 

Imagistik supports Microsoft’s XPS files. You can thus use Imagistik with the Microsoft XPS 

Document Writer (printer) and convert any printable documents to a Tiff file.  For instructions, see 

‘XPS printer driver’ section below. 

You can also use Imagistik for screen capturing, although it is a two-step procedure.  For more 

information, see ‘Screen capture’ section below. 

Imagistik requires the Microsoft Framework 4.0 or later. 

Imagistik supports the standard screen resolutions, but does not fully support the ‘125% ‘Make text 

larger…’ screen resolution option. 

Check frequently for software upgrades.  Click on Help menu button for link. Minor upgrades are 

always free of charge. 

You can download a replacement executable (.exe file, not an install file) that excludes the markup 

options from www.informatik.com/imagistik_limitedversion.zip. 

Disclaimer: Imagistik is supplied without any warranties or liabilities, direct or indirect, of any kind. 

 It is important that you have a secure backup of all files before you edit or manipulate them. 

 Before you use the program, please read and agree with the section on License and warranties 

below.  If you edit images, make sure that you have backup copies and always check the output. 

Demo Version, Licensing 

 

You may use the demo version for up to 30 days. For students and for strictly personal, non-

corporate use, the trial version may be used beyond the 30 days. The demo version is fully-

functional but has some nag messages and part of the image may be partially covered.  For licensing 

and purchasing information, please go to www.informatik.com 

If you purchase a license you will receive an unlock code.  The unlock code is entered in the Help -> 

Registration menu.  Once entered and the program re-started, you will no longer see the Demo nag 

message.   
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Read-only Version  

If you need a version of Imagistik for viewing only, a version that has the markup and edit options 

suppressed, an optional read-only version is available to licensed users.  Contact Informatik Inc and 

ask for an alternative ‘55’ type registration code.  If already registered under the original 

registration code, delete the setup3.xml file, restart the program and enter the new registration 

code.  The setup3.xml file is in the folder shown at the bottom of the Setup window 

Associate file extensions 

If you wish to associate file extensions, for example .tif files, right-click on Tiff file in the folder, then 

choose ‘Open with’ from the dropdown menu. Select the Imagistik executable from the C:\Program 

Files (x86) folder.  The exact procedure depends on the Windows version, but it is fairly straight 

forward.  If you want to make the extension association as the default, check the checkbox ‘Always 

use the selected….’. 

Supported formats 

 

Opening files:  Single and multi-page Tiff (most common compressions), BMP, GIF, PNG, JPEG. 

Saving files: Single or multi-page Tiff, PDF, BMP, GIF, PNG, JPEG.  Monochrome Tiffs are saved in the 

CCITT4 format; color Tiffs are saved in LZW format.  PDF support is basic. 

Printer driver: Imagistik supports Microsoft’s XPS files. You can thus use Imagistik with the 

Microsoft XPS Document Writer (printer) and convert any printable documents to a Tiff file.  For 

instructions, see ‘XPS printer driver’ section below. 

Scanning 

Imagistik does not include a scanning option.  Use the scan function of Windows (Fax and Scan).  For 

a comprehensive scanning software that supports multi-page files, check out the Informatik Scan 

program; free trial download. 

File options 

Open a file 

To open a file, click on the File menu button and select an option from the drop-down list. 
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You can also access Next and Prior from option icons in the vertical icon display (icons shown on the 

left margin of the window). If the current file is a multi-page file you need to press the CTRL key as 

otherwise the next/prior page will open. 

If you use the Next File or Prior File options, make sure that you have specified an extension filter 

when you opened the initial file. You should not use the *.* filter because various un-supported file 

types could be in the same folder.   

If the Tiff file is a multi-page file, you can navigate through the pages by clicking on the Next/Prior 

option in the vertical icon display on the left side of the window. To select a specific page, use the 

Select Page option in the vertical icon display. For various shortcut keys, see the displayed tip 

messages. 

The bottom task bar shows the current file name, the current page and the number of pages in the 

file. 
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Save a file 

The files can be saved in TIFF, PDF, BMP, PNG, GIF or JPEG formats. 

Press the File menu button and choose the Save option, or use the CTRL+S shortcut.  If the 

destination file already exists, you are prompted to choose between ‘Overwrite’ or ‘Append’. 

The Save File dialog defaults to folder that was last used in a save transaction. In Setup, you can 

change the behavior and have the system default to the file’s source folder. 

Tiff images that have not been altered by edit or markups are saved essentially with the original 

compression.  If altered, they are rebuilt; monochrome images are saved in the common CCITT4 

format, and color images are saved in the LZW format.  If rebuilt, some original tags and 

compression specifications may not be preserved. 

The pages of Tiff files can be saved in any order with the powerful ‘Pages’ specification.  You specify 

the ranges in any order, ascending or descending.   Output can be appended to existing Tiff files, 

appended in front or at the back.   

If you save the file in JPEG format, you have an option to specify the JPEG quality. Generally, you 

leave it at the default (high quality).  If you need to reduce the file size, chose a lower quality.  A 

quality value of 50-60 will still give you a good quality and a much reduced file size.  For plain 

images, you can set an even lower value. 

 Imagistik can save the output as a PDF file, although appending is not supported.  PDF support is 

basic and limited. 

If you do image processing (like rotation, resolution etc) or markups (like text annotations), you 

must save the file when done.  If you are working with a multipage file, the changes are temporarily 

saved as you move to another page. When finished with all pages, you must save the overall file. 

Important: If you do markups, remember to save the file when done. 

 

Re-arrange pages of a multipage file 

 You can re-arrange pages with the Save function.  Open the multi-page file.  When the file is open, 

click on the File menu button, then click on Save button.  Specify the new file name (use a file name 

different from the source file).  In the window that opens, click on ‘Specify page ranges’ and type 

the ranges (see also Pagination section below).  Press ‘Save’. Check the output. 

 

Remove a page of a multipage file 

You can remove pages with the Save function.  Open the multi-page file.  When the file is open, click 

on the File menu button, the click on Save button.  Specify the new file name (use a file name 

different from the source file).  In the window that opens, click on ‘Specify page ranges’.  Type the 

ranges of the pages that you wish to keep.  For example, in a 10 page document you want to 
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remove page 4.  Type in the ranges of 1-4, 6-10.  If you do not know the number of the last page, 

simply use E, for example 1-4, 6-E (see also pagination section below).  Press ‘Save’. Check the 

output. 

 

Print a file 

You will find the print option in the File menu.   Shortcut key: CTRL+P. 

 

Pagination 

Imagistik offers powerful pagination options. The pages of TIFF files can be saved in any order.  You 

specify the page range or ranges in any order.   Files and pages can be appended to existing Tiff 

files, appended in front or at the back.  The specified page ranges can be in ascending or descending 

order.  

When you save a multi-page TIFF file, you have the option to specify the pages. 

Samples of page specifications: 

• 1-5 

• 1-5,10-20,25-30 

• 1-5,10,20-16 

• 1-10-20-E 

• EE-1 

(E stands for Last page, EE stands for second last page, EEE third-last, EEEE forth-last) 

 

Close a file 

To close a file, choose the option in the File menu.  This step is generally not needed.  When you 

open a file, the previous file is automatically closed.  
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Viewing options 

 

Many of the viewing settings can be found in the Setup window.  

 

Display size 

The images can be displayed: 

• Fit-to-size 

• Fit-to-width 

• Actual size 

In the vertical icon sidebar you can click on the Size button and toggle between ‘actual size’, 

‘size-to-width’ and the ‘size-to-fit’ displays. Pressing the CTRL while pressing the Size button 

changes to ‘size-to-width’ directly.  The display mode can also be changed in the Setup window.  

The start-up default is set in Setup.    

Please note that the three sizing modes are effective only if the natural image dimensions are 

larger than the display window. 

Magnifier 

A handy feature is the ‘magnifier’.  Most users forget about this feature; keep it in mind.   

While the CTRL key is pressed, draw a rectangle on the displayed image.  The section of the 

rectangle will be displayed in zoom. 

Thumbnail display 

Multi-page Tiff files can be displayed with or without thumbnails.  To activate or turn off the 

thumbnails, click on the thumbnails icon in the upper left corner of the main menu bar, or click on 

the Thumbnails button in Setup.  The start-up default is also set in Setup.     

Scrollbar v Panning 

Large images can be navigated with scrollbars or by panning.  You can switch between the two 

options by pressing the panning icon on the right side of the menu bar, or in Setup.  When editing 

images (markups), only the scrollbar option is available.  The start-up default is also set in Setup.   

Scrollbar lock 

The Setup window also includes options for the scrollbar lock at a fixed position, changing the 

display size and panning/scrollbar for the current session. For some applications you may find the 

scrollbar lock useful.  The scrollbars can be locked so that images always open up at a specified 

scrollbar position.  Set the scrollbar position that you want, then choose the scrollbar lock in the 

Setup window.  A lock icon is displayed in the menu bar when the lock is in effect. 
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Zoom 

Zoom-in and zoom-out options are in the vertical icon display on the left side of the windows.  Click 

on the Cancel Zoom icon to revert to the original display size.   

Shortcut keys for zooming are:  CTRL+ Plus key, CTRL+Minus key. 

By default, each zoom action increases the display by 25% (or decreases it by 20%).  If you press the 

CTRL key while zooming, the change is 5% instead of 25%. 

 

Rotation 

To rotate the image (without saving the image), use the Rotation options in the vertical icon display 

on the left side of the window.  Shortcut keys for rotations are:  CTRL + R for right, CTRL + L for left. 

To save the rotation permanently, use one of the Image Processing options. 

Crop, Copy, Paste  

Imagistik includes the standard Copy and Paste options. It also features an Advanced option that 

offers several additional functions.  This paragraph covers the advanced options. 

Note, the Copy functions lets you adjust the captured rectangle by clicking on side arrows, and you 

can copy the captured image to the Windows Clipboard or save it to a file. 

Paste 

Press the Edit menu button.  Click on the ‘Paste’ button and retrieve the image from the clipboard.  

If there is no image in the clipboard, the Paste button is disabled (grayed).  Before you paste the 

clipboard image you must close the currently displayed image.  Shortcut key (without options) is 

CTRL+V.   

If you paste the image via the Copy-Paste window (recommended), you have an option to center 

the copied image centered on a blank background sheet.  The dimensions of the blank sheet are the 

lesser of the A4 and the Letter Size dimensions, but not less than the copied image.  In the Copy-

Paste window you can also specify your own resolution, which by default is 96x96.  The resolution 

of the currently displayed image is shown in the Copy-Paste window.   

After you have pasted the image, you can review the resolution by clicking on the ‘Image 

information’ menu button. The resolution can by changed with the Image Processing (Markup) 

options.  Finally, save the image to a file.    

If you need to paste a clipboard image to an existing file, use the ‘Image’ option in Markup, as 

follows:  With the target file already open and an image in the clipboard, click on the Markup menu 
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button and select the ‘Image’ option.  The clipboard image is inserted as a movable object.  Drag 

the image object to its correct location. If you want to paste a clipboard image onto a blank sheet, 

instead of opening an existing image file, open a blank sheet from the File menu button, and 

proceed as above. 

 

Copy 

 

The Copy functions copies a selected area of the image to the clipboard or to a file.  

 

There are three methods. 

 

Standard method 

 

1. Press the Copy Paste menu button.  The Copy Paste window is displayed. 

2. Select the type of selection method: Rectangle, Freehand, Polygon, Specify.  Rectangle is 

pre-selected. 

3. Press the ‘Outline and copy’ button.   

4. With your left mouse button pressed, outline the region.  For a Polygon drawing, draw a 

series of lines and press the ‘Close the path’ button in the Confirmation window (the last 

line can be left open).   

5. In the window that opens, select how you want to save the copied section: save to a file or 

copy to the clipboard. You have an option to center the copied image centered on a blank 

background sheet.  The dimensions of the blank sheet are the lesser of the A4 and the 

Letter Size dimensions, but not less than the copied image.  When using the ‘Rectangle’ 

method, a transparent blue rectangle appears overlaid on the open image. Before you save 

the file, you can make small adjustments to any of the four borders. 

6. Press OK button. 

 

Copy/Crop a specified size 

 

1. Press the Copy Paste menu button.  The Copy Paste window is displayed. 

2. Select the ‘Specify…’ option 

3. Press the ‘Outline and copy’ button (now called ‘Specify and copy’).   

4. A window appears that asks you to specify the crop size in Inches or Centimeters.  

Optionally change the resolution. Press OK button. 

5. A transparent blue rectangle appears overlaid on the open image.  Drag the blue rectangle 

to the desired location.   

6. Press the OK button shown in the upper-left corner of the blue rectangle. 

7. In the window that opens, select how you want to save the copied section: save to a file or 

copy to the clipboard. You have an option to center the copied image centered on a blank 

background sheet.  The dimensions of the blank sheet are the lesser of the A4 and the 

Letter Size dimensions, but not less than the copied image.   

8. Press OK button. 
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Shortcut method 

 

1. Press the Windows shortcut key CTRL+C (for basic rectangle capture only). 

2. With your left mouse button pressed, outline the rectangle of interest. 

3. In the window that opens, select how you want to save the copied section: save to a file or 

copy to the clipboard. You have an option to center the copied image centered on a blank 

background sheet.  The dimensions of the blank sheet are the lesser of the A4 and the 

Letter Size dimensions, but not less than the copied image.   

4. Press OK button. 

 

 

The ‘Markup’ function has its own Cut+Paste option. 

 

Crop image 

The traditional Crop function (where the display is replaced by the crop) can be found in the 
Markup option (Image processing). 

Screen capture 

To capture the screen, press on the Screenshot menu button.  Optionally, set the time delay so that 

you can prepare the screen for capture, for example open dropdown menus.  Press the OK button. 

The image of the full screen is displayed in the image window.  With the mouse left button pressed, 

crop the section that you wish capture, then click on the File menu button and save the image.  To 

copy the cropped image to the clipboard instead of saving it to a file, click the Edit menu button and 

choose ‘Copy whole image’.  

Image Information 

Click on the Image Information menu button for information about the current image:  Width, 

height, horizontal and vertical resolution, graphics format and compression, and color depth.  The 

information refers to the original image, before any image processing changes. 

OCR –Optical Character Recognition 

Imagistik includes the basic OCR option.  The default installation includes the language files for 

English.  Separate language files are available (free) for French, German, Italian, Spanish, 

Portuguese and Dutch. Please download zip files from: 

 http://www.informatik.com/files/Tessdata_Dutch.zip 

http://www.informatik.com/files/Tessdata_English.zip 
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http://www.informatik.com/files/Tessdata_French.zip 

http://www.informatik.com/files/Tessdata_German.zip 

http://www.informatik.com/files/Tessdata_Spanish.zip 

http://www.informatik.com/files/Tessdata_Italian.zip 

http://www.informatik.com/files/Tessdata_Portuguese.zip 

http://www.informatik.com/files/Tessdata_Fraktur.zip 

Once you have downloaded the language file, unzip it and place the individual files in the OCR sub-

folder (sub-folder of the folder that contains the imagistik.exe file). 

The OCR option works as follows:  Press the OCR menu button and select the language.  Your 

language will be listed on top.   On the displayed image, outline the area that you wish to OCR. 

 After a few seconds the text will be saved in a temporary text (.txt) file and will be displayed in the 

default viewer for text files.   

Setup 

The Setup window is accessible by clicking on the Setup menu button.  The following default setup 

options are available: 

• Adding or changing linked applications 

• On/off default of thumbnail 

• On/off default of scrollbar/panning 

• Display size default 

 

 

The Setup window also has buttons to change some settings for the current session: 

• Display size 

• Scrollbar/Panning 

• Scrollbar lock 

• Thumbnail display 

Linked applications 

In Setup you can specify up to five (5) applications that can be launched by the Imagistik program. 

 The ‘Linked Applications’ icon is enabled only if you have set up at least one linked application. 

Imagistik passes the current file name to the linked application. If the ‘Prompt for argument switch’ 

checkbox is checked, you are prompted to enter an ‘argument switch’ that some applications 

require, for example ‘/a’.  Linked applications are added in Setup. 

  



 

 

 

Markup and image proces

Imagistik has options for 

• Markups, e.g. drawing, redactions, highlighting, etc

displayed image.  The items can be dragged, edited, cancelled.  Markup is accessible via the 

Markup menu button, the ‘pencil’ icon.

• Image Processing, e.g. resolutions, deskew, rotation, etc.

structure or character of the whole image.  Once changed, it can only be undone via the Undo 

function.  Image processing must be done BEFORE you do Markups.  Image Pro

accessed via the ‘options’ icon menu button.  

Please note: The Limited Version of Imagistik excludes all the Markup options.  

replacement executable (.exe file, not an install file) that excludes the markup options from 

www.informatik.com/imagistik_limitedversion.zip.

Markup 

 

Imagistik has a powerful selection of markup options. 

on the Markup menu button.  You must save the file after using the markup options.

The Markup option includes: 

• Drawing shapes (rectangles, ellipses, arrows, triangles, bubble boxes…)

• Highlight text (yellow marker)

• Watermarks 

• Redact (rectangles or lines)

• Lines (with optional arrowheads)

• Paths (irregular shapes and drawings, with optional arrowheads)

• Text annotations 

• Freehand drawing (with optional arrowheads)

• Cut+Paste (move sections)

• Image insert (file or clipboard images)

• Barcode (Code39) and text stamp

• Curved text  
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and image processing 

, e.g. drawing, redactions, highlighting, etc.  Each markup is a movable item on the 

displayed image.  The items can be dragged, edited, cancelled.  Markup is accessible via the 

Markup menu button, the ‘pencil’ icon. 

, e.g. resolutions, deskew, rotation, etc.  Image processing, changes the 

structure or character of the whole image.  Once changed, it can only be undone via the Undo 

function.  Image processing must be done BEFORE you do Markups.  Image Pro

’ icon menu button.   

Please note: The Limited Version of Imagistik excludes all the Markup options.  You can download a 

replacement executable (.exe file, not an install file) that excludes the markup options from 

nformatik.com/imagistik_limitedversion.zip. 

Imagistik has a powerful selection of markup options.  The markup options are accessed by clicking 

You must save the file after using the markup options.

Drawing shapes (rectangles, ellipses, arrows, triangles, bubble boxes…) 

Highlight text (yellow marker) 

Redact (rectangles or lines) 

Lines (with optional arrowheads) 

Paths (irregular shapes and drawings, with optional arrowheads) 

Freehand drawing (with optional arrowheads) 

aste (move sections) 

Image insert (file or clipboard images) 

Barcode (Code39) and text stamp 

.  Each markup is a movable item on the 

displayed image.  The items can be dragged, edited, cancelled.  Markup is accessible via the 

Image processing, changes the 

structure or character of the whole image.  Once changed, it can only be undone via the Undo 

function.  Image processing must be done BEFORE you do Markups.  Image Processing is 

You can download a 

replacement executable (.exe file, not an install file) that excludes the markup options from 

The markup options are accessed by clicking 

You must save the file after using the markup options. 



 

Image Processing options

 

In addition to the markup options, Imagistik includes several imag

save the file after using the image processing options.

The image processing options include:

• Deskew 

• Rotation 

• Resolution (PPI) 

• Cropping and border cleanup

• Inversion 

• Rotation 

• Color pick (single pixel and 9

• Color fill (color flooding) 

• Conversion to monochrome

• Darken, brighten, sharpen, blur

• Transparency 
• Colorize 

• Despeckle 

• Red-eye removal 

 

Shapes 

The Markup option creates various shapes: Rectangles, ellipses, rounded rectangles, 

triangles, arrow shapes, and text bubbles. 

1. Click on the Markup menu button.

2. Click on the “Shapes, Outlines’ button in the Markup window. 

3. On the image, draw a rectangle that represents the outline of the shape. 

4. Click on the created object and drag it to the correct location.

The ‘Make changes’ window is displayed. 

make the changes later):   Resize horizontally or vertically using the Plus or Minus buttons, move 

the object by clicking, line thickness, opacity, color, fill th

object to the front (if covered by another object). 

The shape can be filled in color or as a hatch pattern.  Click on the Fill options till you find the 

correct fill pattern.  The hatch pattern is non

Creating an arrow shape  
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Image Processing options 

In addition to the markup options, Imagistik includes several image processing options. 

save the file after using the image processing options. 

The image processing options include: 

order cleanup 

Color pick (single pixel and 9-pixel sampling) 

Conversion to monochrome 

, sharpen, blur, contrast 

The Markup option creates various shapes: Rectangles, ellipses, rounded rectangles, 

and text bubbles.  

Click on the Markup menu button. 

Click on the “Shapes, Outlines’ button in the Markup window.  

On the image, draw a rectangle that represents the outline of the shape.     

Click on the created object and drag it to the correct location.   

The ‘Make changes’ window is displayed.  The following changes can be made (now or you can 

Resize horizontally or vertically using the Plus or Minus buttons, move 

the object by clicking, line thickness, opacity, color, fill the shape, dotted or dashed line, bring the 

object to the front (if covered by another object).  You can also delete the object. 

The shape can be filled in color or as a hatch pattern.  Click on the Fill options till you find the 

atch pattern is non-scaled. 

e processing options.  You must 

The Markup option creates various shapes: Rectangles, ellipses, rounded rectangles, 

 

The following changes can be made (now or you can 

Resize horizontally or vertically using the Plus or Minus buttons, move 

e shape, dotted or dashed line, bring the 

 

The shape can be filled in color or as a hatch pattern.  Click on the Fill options till you find the 
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The arrow shape by default is a hollow shape.  The initial direction of the arrow depends how you 

draw the rectangle.  For example, drawing the rectangle from right to left will create an arrow 

pointing left, a rectangle drawn upwards will create the arrow pointing up.  The dimensions of the 

rectangle will shape the size of the arrow.  In the Make Changes window you can rotate the arrow 

at any angle.  Note, for a quick, simple arrow, use the Line option and select the arrowhead option. 

Creating a triangle shape 

By default, the triangle is an equilateral triangle.  If you resize the triangle horizontally the triangle 

will become a regular triangle; if you resize it vertically, the triangle will again become equilateral. 

Creating a bubble shape (‘speech bubble’) 

The bubble can have pointers at four different locations.  The initial location of the pointer depends 

on how you draw the initial rectangle.  For example, drawing the rectangle towards the upper right 

corner creates the initial bubble with a pointer in the upper right corner.  Or, in the Make Changes 

window click on the Flip button, once or more, until the correct shape appears.  The bubble comes 

without the text.  You need to add the text with the Text option.  Simply drag the text object into 

position inside the bubble.  If the text object is hidden behind the bubble, bring it to the front with 

the ‘To front’  button in the ‘Make Changes’ window.  With the Adjustment option you can move 

the individual pointers in any direction. Click on ‘Find Point’ button and use the Plus/Minus buttons 

to move the pointer. 

 

Highlight 

The Highlight option highlights a selected area with a color, without covering the underlying text.   

1. Click on the Markup menu button. 

2. Click on the “Highlight’ button in the Markup window.  

3. On the image, draw a rectangle that represents the outline of the area to highlight.     

4. Click on the created object.  Drag it to the correct location. 

The ‘Make changes’ window is displayed.  The following changes can be made (now or you can 

make the changes later):   Resize horizontally or vertically using the Plus or Minus buttons, move 

the object by clicking, change the color, bring the object to the front (if covered by another object). 

 You can also delete the object. 

 

Redact 

The Redact option covers a selected area in white or in black (or other colors).  There are two 

Redact options:  

• Redaction in rectangular form 
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• Redaction in line form 

1. Click on the Markup menu button. 

2. Click on the ‘Redact’ button in the Markup window.  

3. Optionally, change the color (toggle between black and white). 

4. On the image, draw a rectangle that represents the area to be redacted.    

5.  Click on the created object and adjust the location. 

The ‘Make changes’ window is displayed.  The following changes can be made (now or you can 

make the changes later):   Resize horizontally or vertically using the Plus or Minus buttons, move 

the object by clicking, change the color, line thickness (for line redaction), bring the object to the 

front (if covered by another object).  You can also delete the object. 

You can also redact irregular shapes with the Path or Freehand methods.  Draw the shape and fill it 

with a color. 

 

Lines 

Follow these steps to draw a line: 

1. Click on the Markup menu button. 

2. Click on the ‘Lines’ button in the Markup window.  

3. On the image, draw a line in any direction.     

4. Click on the created object and drag it to the correct location.   

Consistent with Windows standards, the line is drawn exactly horizontally or vertically if you press 

the SHIFT key while drawing the line. 

The following changes can be made in the ‘Make changes’ window  (now or you can make the 

changes later):   Move the object by clicking, change the color, line thickness, opacity, joint 

adjustments,  arrowheads (one or both ends), dotted or dashed lines,  bend the line, bring the 

object to the front (if covered by another object).  You can also delete the object.  With the 

Adjustment option you can move the endpoints in any direction. Click on ‘Find Point’ to locate the 

endpoint and use the Plus/Minus buttons to move the joint. 

 

Paths 

Follow these steps for drawing a path: 

1. Click on the Markup menu button. 
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2. Click on the ‘Paths’ button in the Markup window.  

3. On the image, draw a line in any direction.     

4. Click on the created object and drag it to the correct location.   

The Path is a combination of lines.  Draw the first line, then click on end point of then next line.  The 

last line segment of the path can be undone with the Undo option in the confirmation window on 

the left side of the screen. 

When done with all the lines, press one of the ‘OK Done’ buttons in the small confirmation window 

on the left side of the screen. You have the option to automatically close the path.   

The following changes can be made in the ‘Make changes’ window  (now or you can make the 

changes later):   Move the object by clicking, change the color, line thickness, opacity, joint 

adjustments,  arrowheads (one or both ends), dotted or dashed lines,   fill the shape (color, hash 

pattern), bring the object to the front (if covered by another object).  You can also delete the 

object.  With the Adjustment option you can move the individual joints in any direction. Click on 

‘Find Point’ to locate the joint and use the Plus/Minus buttons to move the joint. 

The shape can be filled in color or as a hatch pattern.  Click on the Fill options till you find the 

correct fill pattern.  The hatch pattern is non-scaled. 

Important: When selecting the path, closed or open, even filled, you must click on the rim of the 

drawing, not the inside area. 

If you fill the path with white color, you no longer see the rim of the drawing, and it will be difficult 

to select the object.  For display only, not the final rendering, any white color is shown as a slightly 

off-white color. 

The path points can be changed. Click on the ‘Adjust points’ option, press on the ‘Set point’ button 

and move the path joint in any direction. 

 

Text annotations 

Follow these steps for text annotations: 

1. Click on the Markup menu button. 

2. Click on the “Text’ button in the Markup window.  

3. The text window is displayed.  Enter the text, change the font and color. You can recall the 

previous text (current session) by clicking on the Text recall button.   

4. Click on the image at the point where you want to insert the text.  For rotated text, draw a 

line at the rotation angle. 

5. Click on the created object and drag it to the correct location.   

The following changes can be made in the ‘Make changes’ window  (now or you can make the 

changes later):   Resize the text, move the object by clicking, rotation, return to the text window 

where you can make other text changes, bring the object to the front (if covered by another object). 

 You can also delete the object. 
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Text inserts are generally hard to spot on the image.  To make the insert more visible, you may want 

to show them highlighted in yellow.  Choose the ‘yellow background’ option.  The yellow 

highlighting will only be for display; it is not realized when the file is saved or printed.   

 

Freehand drawing 

Follow these steps for freehand drawing: 

1. Click on the Markup menu button. 

2. Click on the “Freehand’ button in the Markup window.  

3. In the image window, draw any pattern.   The pattern completes when you release the 

mouse button. 

4. Click on the drawing and drag it to its correct location.   

The following changes can be made in the ‘Make changes’ window  (now or you can make the 

changes later):   Move the object by clicking, change the color, line thickness, opacity, add 

 arrowheads (one or both ends),  fill the area, bring the object to the front (if covered by another 

object).  You can also delete the object. 

The shape can be filled in color or as a hatch pattern.  Click on the Fill options till you find the 

correct fill pattern.  The hatch pattern is non-scaled. 

Important: When selecting the freehand drawing, closed or open, even filled, you must click on the 

rim of the drawing, not the inside area. 

If you fill the freehand drawing with white color, you no longer see the rim of the drawing, and it 

will be difficult to select the object.  For display only, not the final rendering, any white color is 

shown as a slightly off-white color. 

 

Cut+Paste 

With the Cut+Paste option you can select an area on the image and move it to another spot.    

1. Click on the Markup menu button. 

2. Click on the “Cut + paste’ button in the Markup window.  

3. Outline the copy area. 

4. Select the copied rectangle and move it to the new location. 

The following changes can be made in the ‘Make changes’ window  (or you can make the changes 

later):   Move the object by  clicking, resize by dragging the arrow on right border or by clicking, 
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change opacity, make background transparent, bring the object to the front (if covered by another 

object).  You can also delete the object. 

The Cut+Paste leaves the vacated area in white.  You can activate the white area and change the 

color, or click on the Delete button.  If you prefer to ‘copy’ instead of ‘cut’, i.e. leave the selected 

area untouched, press the CTRL key while you click on the Cut+Paste button (but let go before you 

draw the rectangle).  Alternatively, activate and delete the white area. 

 

Image insert 

Follow these steps to insert an image: 

1. Click on the Markup menu button. 

2. Click on the ‘Image’ button in the Markup window.  If there is an image in the clipboard, you 

are given the choice of selecting a file or the clipboard image.  

3. A ‘File Open’ dialog prompts you for the file name.  Select the file (*.tif, *.bmp, *.png, *.jpg, 

*.gif). 

4. Click on the created object and drag the created object to its correct location.   

The following changes can be made in the ‘Make changes’ window (now or you can make the 

changes later):   Resize the image, move the object by clicking, rotation, opacity, make the white 

background transparent, bring the object to the front (if covered by another object).  You can also 

delete the object. 

You can also resize the image by dragging the arrow on the right border of the image. 

 

Watermark, Barcode, Stamp 

The option inserts a watermark, a barcode in the Code39 format only, or a simple text ‘stamp’.  

1. Click on the Markup menu button. 

2. Click on the “Marks, Stamp, etc.’ button in the Markup window.  

3. The text window is displayed.  Enter a short text string, and press the ‘Watermark’, ‘Stamp’ 

or ‘Barcode’ button. 

4. Click on the created object and drag it to the correct location.    

The following changes can be made in the ‘Make changes’ window (now or you can make the 

changes later):   Resize the object, move the object by clicking, rotation (right angle only), bring the 

object to the front (if covered by another object).  You can also delete the object. 
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Curved text 

You may need to add curved text, for example to show the street name on a map.   

1. Click on the Markup menu button. 

2. Click on the “Curved text’ button in the Markup window.  

3. The text window is displayed.  Enter the text, change the font and color. You can recall the 

previous text (current session) by clicking on the Text recall button.   

4. With the mouse, draw a line that represents the approximate angle of the text.  The angle is 

the direction of an imaginary straight line from the first letter to the last letter of the curved 

text.  Draw the line in a clockwise fashion if the curve is to bend leftward, otherwise 

counterclockwise.  Practice will make perfect.  

5. Click on the created object and drag it to the correct location.     

Many changes can be made to the inserted objects in the ‘Make Changes’ window.  The Make 

Changes window opens automatically when you activate an insert object (i.e. click on the object). If 

an object is partially covered behind another object, click on it and press the ‘To front’ button. You 

can also delete an object. 

 

Deskew 

Deskewing  can be run manually or automatically.  If the automatic deskew does not give you the 

desired result, do a manual deskew.   

1. Click on the Image Processing menu button. 

2. The Image processing window is displayed.  Select the Deskew option. 

3. Press  ‘Manual deskew’ or ‘Automatic deskew’ button. For manual deskewing,  draw a line 

along the skew line, horizontal or vertical. 

 

Resolution (ppi) 

The Resolution function has two options: with or without sampling.  Sampling simply means that 

the image is rebuilt to display at the original size, i.e. pixels are added or removed to reflect the new 

resolution. 

Resolution should always be run before any markups. 

1. Click on the Image Processing menu button. 

2. The Image processing window is displayed.  Select the Resolution option. 



 

3. Specify the resolution in a format such as: 

300 

200x100 

90% 

4. Press on ‘With resampling’ or ‘No resampling’ button.

 

Rotation 

Rotation saves the page at the specified orientation.

Rotation should always be run before 

1. Click on the Page Imaging Processing menu button.

2. The Image processing window is displayed. 

3. Press on ‘Clockwise’, ‘Counterclockwise’ or ‘

right angles, use the Deskew option.

 

Crop and border cleanup 

The border cleanup takes the outlined center area and places it on a white canvas of the original 

size.  The option is useful to remove spots in the

from skewed scanning you can also remove the black with the Color

Options’ button.  The optional Crop removes the border.

Border Cleanup should always be run before any mark

1. Click on the Image Processing menu button.

2. The Image processing window is displayed. 

3. Outline the inside area of the image; the area outside of the

whitewashed (or clipped in the case of the 

4. Click on the ‘Clean borders’ or the ‘Crop 

 

Other Options 
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Specify the resolution in a format such as:  

Press on ‘With resampling’ or ‘No resampling’ button. 

the page at the specified orientation. 

before any markups. 

Click on the Page Imaging Processing menu button. 

The Image processing window is displayed.  Select the Rotation option. 

Press on ‘Clockwise’, ‘Counterclockwise’ or ‘Upside-down’ button. For rotations other than 

right angles, use the Deskew option. 

The border cleanup takes the outlined center area and places it on a white canvas of the original 

The option is useful to remove spots in the border areas.  If the borders have black sections 

from skewed scanning you can also remove the black with the Color-flooding option (via the ‘Other 

The optional Crop removes the border. 

Border Cleanup should always be run before any markups. 

Processing menu button. 

The Image processing window is displayed.  Select the Border Cleanup option.

Outline the inside area of the image; the area outside of the outline rectangle will be 

whitewashed (or clipped in the case of the Crop option). 

Click on the ‘Clean borders’ or the ‘Crop image’ button. 

For rotations other than 

The border cleanup takes the outlined center area and places it on a white canvas of the original 

If the borders have black sections 

flooding option (via the ‘Other 

Select the Border Cleanup option. 

outline rectangle will be 
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Click on the Image Processing menu button. 

The Image processing window is displayed.  Select the ‘Other’ option.  Some options are enabled 

only for color images. 

 

Color flooding  

Color flooding fills a contiguous area with the selected color.  Press on the Color flooding button. 

 The color dialog is displayed; select the flooding color, and press OK. The cursor changes to ‘color 

flood’.  Click on the pixel that represents the color of the contiguous area that you wish to flood.  If 

you need to fill the area with a color that already exists in the image, you may want to use the Color 

pick option to determine the color. 

Color pick 

The Color pick option returns the color of a specified pixel or a 9-pixel cluster.  Select the option and 

click on the pixel in the image that you wish to sample.  To color is posted to the color dialog.  To 

obtain the RGB value of the color, open the color dialog, select the color and press on the ‘Define 

Custom Colors’ button. 

Convert to monochrome 

The option converts a color image to black and white, using dithering.  Some detail and quality will 

be lost, but the file size will be greatly reduced.  Use with caution. 

Inversion 

The inversion option reverses the color of the image.  It is used rarely but can be useful if the 

original image is negative and needs to be fixed. 

Despeckle 

The Despeckle option removes ‘noise’ from monochrome images. The size of the pixel clusters 

(contiguous black pixels) depends on the resolution of the image.  A 100 resolution image removes 

pixels clusters up to a maximum of 5 pixels, maximum width or height of 3 pixels.  A 300 resolution 

image increases the threshold to approximately 40 and 10. 

 

Darken, brighten, contrast, sharpen, blur 

These options are used mainly for photos.  Click on ‘Darken, brighten, …’  and select the function.  

Specify the value.  If the rendition is not correct, repeat the process, or do an Undo and select a 

higher or lower value. 

Colorize 

You can colorize an image.  The option is used mainly for photos.  This image is rendered in one 

selected color at different lightness values. For Sepia (antique look) use RGB colors 112-66-20. 
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Make transparent 

The option is available only for single-page color images, and it should be used as the last step. You 

can render a color image at any opacity level between 10 and 100; 10 being almost fully 

transparent. A level of 100 is used to cancel a transparency. The function includes an option to 

make a selected color totally transparent.  The output is saved as a 32-bit image (TIFF, BMP, PNG 

only).   

Red-eye removal 

The Red eye removal option removes red eyes in photos.  When selecting the option, the cursor 

changes to a Cross.  Outline the area of the red eye.   

 

General notes about the Markup options 

The markup options are easy to execute and mainly self-explanatory.  Here are some guidelines: 

Individual markup objects can be dragged and re-positioned.  When you click on a markup object, 

the ‘Make Changes’ window appears next to it, where you can change many of the properties of the 

object, such as color, line thickness, transparency, rotation, etc.  You can also delete individual 

markup objects (or press the Delete key) , or bring an object to the front.    

The markups are treated as a group.  Please note that when you leave the markups (if you go to 

another page), they are frozen; you can no longer change them individually.  You can use the Undo 

to revert back to the page before the markups.   Edit changes, such as resolution, rotation, deskew, 

should be done before you create any markups.   

When you markup pages of a multi-page Tiff file, the changes to a page are automatically saved to a 

temporary file when you move to another page.  When you are finished with the markups for the 

file, you must save the file.   

With multi-page files, as you move to another page, the markup objects  are frozen; you can no 

longer individually change them, but you can restore the page back to its original.  Once you are 

back to the restored page, you can retrieve the last set of markup objects.  You have also an option 

to delete all changes to all pages and restore to the original file.  All these options are found in the 

main Markup window.  

To emphasize, the Image Processing options (e.g. resolution, rotation, deskew, etc) must always be 

run BEFORE the Markup options (e.g. drawing, redaction, etc). The markup objects are frozen when 

you move from Markup inserts to any of the Image Processing options. 

 



 

File restore (utilities) 

 

File restore includes the following options:

• Retrieve the last set of markup inserts.

inserts when doing an image process (e.g. resolution, deskew, etc), and you wish to re

them after an Undo, or if you need to copy the inserts on various pages.

• Restore the currently displayed page.

• Restore the file (all pages).

 

Undo, Redo 

Imagistik has limited options for Undo and Redo. 

annotations, etc. are handled as a group. 

removed.  They are re-inserted with

processing option (such as watermark, deskew, 

confirmed and frozen as a group, and they can no longer be changed

can press the Undo and return to the state

restored.   

In the File utilities you will find two handy options:  Restore and Re

you can restore a page to its original and re

‘File utilities’ section in this user guide. 

Convert any file to Tiff (XPS printer driver

Imagistik supports Microsoft’s XPS files. You can use Imagistik with the Microsoft XPS Document 

Writer (printer driver) and convert any printable documents to a Tiff file

1. Open any document in the document’s nati

2. Open the file in the file's native application.

3. Select the Print option and choose 'Microsoft XPS Document Writer' as the printer.

4. In the 'File name' field select the output folder and enter a file name with the .xps 

extension.  The 'Save type as' option must be set to .xps (not .oxps). 

5. Wait while the system completes the conversion.  If nothing happen, you may need to 

release a flickering icon at the bottom of the screen.

6. When the 'print' process is completed, open the .xps file in the Imagi

the 'Open file' dialog Extension dropdown list, select 'XPS as Tiff 

Tiff - Color'. Press 'Open' button.
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the following options: 

Retrieve the last set of markup inserts. This option is useful if you have lost the live markup 

inserts when doing an image process (e.g. resolution, deskew, etc), and you wish to re

you need to copy the inserts on various pages. 

Restore the currently displayed page.  All markups are deleted. 

Restore the file (all pages).  All markups are deleted. 

Imagistik has limited options for Undo and Redo.  Remember, the markups (shapes, lines, 

annotations, etc. are handled as a group.  If you press the Undo button, all the markup objects are 

inserted with the Redo.  If you have live markup inserts and choose an image 

processing option (such as watermark, deskew, etc), all the pending markup items are 

and frozen as a group, and they can no longer be changed individually.  However, you 

return to the state before the processing option, with the markup objects 

tilities you will find two handy options:  Restore and Re-insert last set of markups. So, 

you can restore a page to its original and re-insert the last set of markup inserts.  Please

‘File utilities’ section in this user guide.  

XPS printer driver) 

Imagistik supports Microsoft’s XPS files. You can use Imagistik with the Microsoft XPS Document 

) and convert any printable documents to a Tiff file (or PDF, etc).

Open any document in the document’s native program.   

Open the file in the file's native application. 

Select the Print option and choose 'Microsoft XPS Document Writer' as the printer.

In the 'File name' field select the output folder and enter a file name with the .xps 

e as' option must be set to .xps (not .oxps).  

Wait while the system completes the conversion.  If nothing happen, you may need to 

release a flickering icon at the bottom of the screen. 

When the 'print' process is completed, open the .xps file in the Imagistik Image Viewer.  In 

the 'Open file' dialog Extension dropdown list, select 'XPS as Tiff - Monochrome' or 'XPS as 

Color'. Press 'Open' button. 

This option is useful if you have lost the live markup 

inserts when doing an image process (e.g. resolution, deskew, etc), and you wish to re-insert 

es, lines, 

the markup objects are 

If you have live markup inserts and choose an image 

etc), all the pending markup items are 

However, you 

before the processing option, with the markup objects 

insert last set of markups. So, 

insert the last set of markup inserts.  Please read the 

Imagistik supports Microsoft’s XPS files. You can use Imagistik with the Microsoft XPS Document 

(or PDF, etc).   

Select the Print option and choose 'Microsoft XPS Document Writer' as the printer. 

In the 'File name' field select the output folder and enter a file name with the .xps 

Wait while the system completes the conversion.  If nothing happen, you may need to 

stik Image Viewer.  In 

Monochrome' or 'XPS as 
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7. The file now opens and has already been saved as a Tiff.  The conversion is complete.  The 

xps file is deleted.  Optionally, do markups, or change the file to a format other than Tiff. 

Technical Support 

The technical support contact information is shown in http://www.informatik.com/support.html.  

Before you contact Support, please review any FAQ at www.informatik.com/faq/imagistik.html.  

Also, check and make sure that you are running the latest version.  For version update information, 

please visit www.informatik.com/updates/imagistik.html. 

Copyright and Trademark Notices 

Imagistik is a trademark of Informatik Inc. 

Informatik OCR Copyright Notice: 

Markups, graphics editing and user interface (excluding Tesseract). 

Copyright 20012-2017 Informatik Inc.  All Rights Reserved.  Supplied AS IS without any liability, 

direct or indirect.  Backup all files before you use them in this program.  You must also read and 

agree to the License terms, shown below. 

 TESSERACT Copyright and License Notice: 

Copyright Protected and Licensed under the Apache License, Version 2.0 (the "License"); you may 

not use this file except in compliance with the License. You may obtain a copy of the License at 

http://www.apache.org/licenses/LICENSE-2.0. Unless required by applicable law or agreed to in 

writing, software distributed under the License is distributed on an "AS IS" BASIS, WITHOUT 

WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied. See the License for the 

specific language governing permissions and limitations under the License. 

 Program uses parts of Bit Miracle:  

Copyright (c) 2008-2011, Bit Miracle, All rights reserved. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" 

AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 

ARE DISCLAIMED. IN NO EVENT SHALL BIT MIRACLE BE LIABLE FOR ANY DIRECT, 

INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 

(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 

LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 

ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 

(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 

THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

License, Warranty, Disclaimer 
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Please read the terms carefully before installing and using the software, as such conduct will 

indicate your acceptance of all of the terms of this license agreement.  If you do not agree with the 

terms, the software cannot be licensed to you and you must un-install and return the software to 

Informatik Inc, or its supplier or distributor. 

This License Agreement is a legal agreement between Informatik Inc. ("Licensor"), a Pennsylvania 

Corporation, and you, the user ("Licensee"), and is effective the date Licensee installs the software. 

This Agreement covers all materials associated with the Imagistik Image Viewer software, including, 

without limitation, the downloadable software product, online documentation, and any additional 

supporting electronic files (herein, the "Software"). 

The evaluation version may be used for 30 days after installation.  Unless otherwise agreed, it is 

unlawful to use the software after the 30 day evaluation period without licensing the software and 

paying the license fees.  If a license is not obtained before the expiration of the 30 day evaluation 

period, the Software must be un-installed and destroyed.  For personal non-corporate and for 

student use, the trial version may be used beyond the 30 days. 

1. GRANT OF LICENSE 

Licensor hereby grants to you, and you accept, a nonexclusive license to use the Software according 

to the following condition: 

For each User Unit, you may use the Software on one (1) personal computer or workstation, owned, 

leased, or otherwise controlled by you and used by you for personal or business purposes, and as 

authorized in this License Agreement. A single license represents one (1) User Unit.  A multi-user 

pack represents the implied number of User Units.  The Software may not be transferred to other 

computers over a network. The software may be installed on one (1) laptop or equivalent. The 

Software may not be installed on a web server without a special license.  

A site license covers an unlimited number of software installations, on PCs, workstations, servers, for 

use by the licensed company, at one site, including laptops or equivalent used by employees attached to 

that site.  Web applications are excluded. Technical support is to be handled via one central person or 

department. 

An enterprise license covers an unlimited number of software installations, on PCs, workstations, 

servers, for use by the licensed company, world-wide, including parent, subsidiaries and affiliates. Web 

applications are excluded. Technical support is to be handled via one central person or department. 

2. LICENSOR'S RIGHTS 

Licensee acknowledges and agrees that the Software is proprietary to Licensor and protected under 

international copyright law. Licensee further acknowledges and agrees that all right, title, and 

interests in and to the Software, including associated intellectual property rights, are and shall 

remain with Licensor. The License Agreement does not convey to Licensee an interest in or to the 

Software, but only a limited right of use that may be revoked in accordance with the terms of this 

License Agreement. 

3. OTHER RESTRICTIONS 
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Licensee agrees to make no more than one (1) backup copy of the Software. Licensee agrees not to 

assign, sublicense, transfer, pledge, lease, rent, or share the rights assigned under this License 

Agreement. Licensee agrees not to reverse assemble, reverse compile, or otherwise translate the 

Software. 

4. TERM 

This License Agreement is effective when Licensee installs the Software and shall terminate only if 

the terms of this License Agreement are broken. Licensee agrees to destroy the Software upon 

termination of this License Agreement. 

5. NO WARRANTY; LIMITATION OF LIABILITY 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" 

AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 

ARE DISCLAIMED. IN NO EVENT SHALL LICENSOR BE LIABLE FOR ANY DIRECT, INDIRECT, 

INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 

LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, 

OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 

LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 

NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 

EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

6. GOVERNING LAW 

This License Agreement shall be construed and governed in accordance with the laws of 

Pennsylvania. 

7. SEVERABILITY 

Should any court of competent jurisdiction declare any term of this License Agreement void or 

unenforceable, such declaration will have no effect on the remaining terms hereof. 

8. NO WAIVER 

The failure of either party to enforce any rights granted hereunder or to take action against the 

other party in the event of any breach hereunder shall not be deemed a waiver by that party as to 

subsequent enforcement of rights or subsequent actions in the event of future breaches. 

 

 

 


